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RESUMO

Utilizando aparato experimental retangular de acrilico foram empregados dois
tipos de refratarios porosos nos quais se injetou gas inerte em diferentes vazdes.
Esses refratarios sdo comumente utilizados para a injegdo de gas inerte em
valvulas e plugs de lingotamento continuo e panela, respectivamente. O objetivo
do estudo foi caracterizar o tamanho e a velocidade das bolhas formadas a partir
da injecado do gas através do refratario. As bolhas foram caracterizadas em um
recipiente contendo um volume constante de agua. A caracterizagao das bolhas
foi realizada por meio do método Shadow Sizing (medi¢gdo por sombras). Além
disso, um dos principais focos deste estudo foi determinar a melhor configuragao
do sistema Shadow Sizing visando possibilitar a caracterizacdo de um maior
numero de bolhas por imagem, reduzindo ou evitando a medi¢gao de bolhas
sobrepostas ou fragmentadas. Os resultados demonstraram que a técnica
Shadow Sizing foi significativamente mais eficiente, detectando até 3.119 bolhas
em uma unica condi¢ao de teste, contra 992 bolhas medidas com o ImageJ®. O
Shadow também identificou uma distribuicdo mais ampla de tamanhos, com alta
concentracdo de bolhas entre 1,0 mm e 2,0 mm. Ja o ImageJ® apresentou
limitagdes na detecgdo de bolhas pequenas, registrando didmetros meédios
maiores devido a dificuldade em medir corretamente essas bolhas, resultando
em valores maiores em comparacao ao Shadow Sizing, além de menor precisao

em cenarios com alta densidade de particulas.

Palavras-chave: Bolhas; Gas Inerte; Shadow Sizing; Refratario, Lingotamento

Continuo.



ABSTRACT

Using a rectangular acrylic experimental apparatus, two types of porous
refractories were employed, into which inert gas was injected at different flow
rates. These refractories are commonly used for inert gas injection in continuous
casting valves and ladle plugs, respectively. The aim of the study was to
characterize the size and velocity of the bubbles formed from gas injection
through the refractory. The bubbles were characterized in a container filled with
a constant volume of water. Bubble characterization was carried out using the
Shadow Sizing method. Furthermore, one of the main focuses of this study was
to determine the best configuration of the Shadow Sizing system in order to
enable the characterization of a larger number of bubbles per image, reducing or
avoiding the measurement of overlapped or fragmented bubbles. The results
showed that the Shadow Sizing technique was significantly more efficient,
detecting up to 3,119 bubbles in a single test condition, compared to 992 bubbles
measured with ImageJ®. Shadow Sizing also identified a wider size distribution,
with a high concentration of bubbles between 1.0 mm and 2.0 mm. ImageJ®, on
the other hand, showed limitations in detecting small bubbles, recording larger
average diameters due to the difficulty in accurately measuring these bubbles,
resulting in higher values compared to Shadow Sizing, in addition to lower

accuracy in scenarios with high particle density.

Keywords: Bubbles; Inert Gas; Shadow Sizing; Refractory; Continuous Casting.
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1 INTRODUGAO

No processo de fabricagado do aco € comum o uso da injecéo de gas, seja
durante o processo de refino secundario, em que o ago liquido sera agitado com
gas inerte para favorecer a remogao de inclusdes, nas panelas para intensificar
a homogeneizagdo, ou no lingotamento continuo para evitar deposicdo de
alumina no sistema de valvulas. A inje¢do de gas tem como principal beneficio
estimular a remocdao de inclusdes e intensificar a homogeneizagdo de

temperatura e composi¢céo quimica (Pereira, 2011).

Os reatores metalurgicos podem ser conceituados como colunas de
bolhas formadas a partir da injecdo de gas em seu interior. De maneira
simplificada, pode-se entender que o reator esta preenchido com aco liquido, no
qual o gas é introduzido, gerando bolhas que se dispersam pelo liquido,
promovendo fendmenos de mistura, homogeneizacao e transferéncia de massa
(Lopes, 2012).

Para a caracterizacao das bolhas, novos modelos matematicos e fisicos
vém sendo criados para que se possa utilizar novos métodos para a realizacao
das medidas de uma bolha presente dentro do reator metalurgico. Métodos
utilizando analise visual ou técnicas automaticas de correlagdo de imagens sao
empregadas para determinar a velocidade, tamanho e dimensdo de uma bolha
(Broder e Sommerfeld, 2007). Conforme for o tamanho do reator se tem a
preferéncia para qual tipo de método sera utilizado, consequentemente se tem a
existéncia de diferentes métodos que tem sido escolhido e aplicados para a

realizagcédo de caracterizagédo de bolhas (Forero, 2012).

O modelamento fisico € uma técnica experimental que é utilizada para
simular em escala fenbmenos complexos, permitindo a visualizagao e analise de
variaveis de dificil acesso em escala real. Nesses casos, o modelamento fisico
proporciona dados confiaveis para validacdo de hipoteses, desenvolvimento de
equipamentos e otimizagdo de processos, essa abordagem é essencial para
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compreender e otimizar processos metalurgicos de forma segura e econémica
(Pereira, 2011).

Assim, o principal objetivo desse trabalho € estudar a formagao, tamanho
e dimensao das bolhas formadas através da inje¢ao de gas inerte em um modelo
acrilico contendo dois tipos de refratarios utilizados em valvulas submersas de
lingotamento continuo. E importante frisar que materiais porosos com variadas
distribuicdes de tamanho de poro irdo permitir alterar o tamanho da bolha. Busca-
se aplicar a técnica de medigao Shadow Sizing e definir os melhores parametros

de tratamento de imagens para obter bons resultados com esse método.
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2 OBJETIVOS

2.1 Objetivo Geral

Determinar a configuragdo de sistema Shadow Sizing e explorar as

possibilidades fornecidas pelo programa para caracterizagdo de bolhas em

sistema agua/ar em modelos fisicos de reatores metalurgicos.

2.2 Objetivo Especifico

Realizar a revisao da literatura sobre aplicagcdes do sistema Shadow
Sizing.

Realizar medi¢gées em um sistema com inje¢ao de gas no refratario poroso
e comparar com medi¢des manuais utilizando o software ImageJ®.

Identificar a melhor configuragao do programa quanto a:
o Percentual de linearizagdo da imagem
o Definir parametros para medicao de particulas,
o Bolhas com contornos abertos ou com sobreposi¢ao.

Elaborar roteiros para orientar a operacao e realizacdo de medigao de
bolhas em modelos fisicos de reatores metalurgicos com injecéo de gas.

14



3 REFERENCIAL TEORICO

3.1 Refino Secundario

A industria siderurgica tem como caracteristica produzir varios insumos
para diversos segmentos industriais, como o uso na industria automotiva, na
construgao civil, entre outros. E sempre se busca melhorias para esses

processos para que o ago venha a ser o mais refinado possivel (Barral, 2016).

E nessa parte do processo conhecido como refino secundario que se tem
a ultima oportunidade de se fazer alteragcbes na composicdo quimica do acgo
(Irons, Senguttuvan e Krishnapisharody, 2015). Apés o refino secundario, o0 ago
liguido € conduzido para o lingotamento continuo, etapa em que o metal &
solidificado de forma controlada em lingotes ou placas, garantindo a formacéao
de uma microestrutura uniforme e minimizando defeitos, como inclusdes e

trincas, que possam comprometer a qualidade do produto.

E durante o processamento de refino do aco que ocorre o ajuste de
composi¢ao quimica e da sua temperatura e onde também ocorre a eliminacéo
das impurezas presentes no ago (Araujo, 1997). Para este processo € utilizado
dois equipamentos fundamentais para o refino: o forno e a panela (Finardi, 1979
apud Hartmann, 2012).

O desgaseificador a vacuo RH é um equipamento amplamente utilizado
na produgédo de ago, integrando o processo de refino secundario. Sua fungéo
principal € remover gases dissolvidos no a¢o, como hidrogénio, oxigénio e
nitrogénio, em concentracdes que nao poderiam ser alcangadas por métodos
convencionais sem a aplicagdo de vacuo. Esse processo de desgaseificagdo
contribui diretamente para a melhoria da qualidade do aco, reduzindo a formagao
de porosidade, inclusbes gasosas e defeitos internos, além de favorecer a
homogeneizagdo da composi¢cado quimica do metal (Barral, 2016).
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3.2 Injecao de Gas
3.2.1 Efeito da injegao de gas

A homogeneizagado do aco liquido ocorre no final do processo, é nessa
etapa que um gas inerte, normalmente gas argonio é injetado através da valvula
submersa no lingotamento continuo, cria-se entdo uma atmosfera desoxidante
na carga metalica (Betega, 2022). No lingotamento continuo, o borbulhamento
de gas se torna essencial no tratamento cinético das reagdes, fazendo com que
ocorra uma restricdo das zonas mortas e a retirada de inclusdes presentes (Silva
et al.,, 2017). Nesse borbulhamento de gas, utiliza-se em geral argbnio ou

nitrogénio (Krishnapisharody e Irons, 2010).

Com a injecao de gas no aco liquido pode se notar beneficios, sendo um
deles a homogeneizagao térmica e quimica do banho metalico, a flotagcao de
inclusbes e a melhoria de refino (Krishnapisharody e Irons, 2010;
Krishnapisharody e lrons, 2013). Porém se o gas nao for bem utilizado no
borbulhamento podem aparecer maleficios, como a reoxidacédo do aco trazendo

prejuizos ao produto final (Silva et al., 2017).

As bolhas presentes na agitacdo do banho metalico para a formagao do
aco tém grande influéncia tanto no tempo da mistura quanto na capacidade de
flotar as inclusdes que aparecerao no reator, esse fluxo de gas esta presente no
lingotamento continuo, panela de aciaria e no desgaseificador RH que é

caracterizado pela turbuléncia, tamanho de bolhas presentes (Barral, 2016).

A remocgao das inclusdes presentes no lingotamento continuo se da
através da injecao de gas na valvula submersa, isso ocorre, pois, as particulas
presentes na liberagado do gas interagem com a frente de solidificagdo do ago, o
gas é injetado através da valvula submersa, acarretando a formagéo de bolhas,
para que aconteca a remocao das inclusdes presentes por método de flotagao,
dessa forma € possivel obter um aco livre de inclusbes com a limpidez
necessaria. Porém, as grandes bolhas formadas, apés sairem da SEN, acabam

escapando para a camada de escoéria presente proxima a valvula, ocasionando
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grandes defeitos, como trincas e inclusdes na parte superior do produto. Esse
fendbmeno esta associado ao fato de que bolhas maiores tém maior empuxo e
menor tempo de permanéncia no banho, o que reduz sua eficiéncia na remogéao
de inclusdes e aumenta a probabilidade de aprisionamento na superficie do acgo.
Além disso, a interagao entre essas bolhas e a escoria pode gerar instabilidades
no menisco, favorecendo a entrada de escoéria para dentro do aco liquido e,
consequentemente, prejudicando a qualidade superficial e interna do produto
(Santos Junior, 2020).

3.2.2 Tamanho e distribuicdo de bolhas

As bolhas formadas a partir do borbulhamento de gas nos reatores
metalurgico possuem papel importante nos processos industriais principalmente
na siderurgia. O tamanho da bolha ira interferir diretamente no refino do aco,
quanto menor for o tamanho dessa bolha melhor sera a eficiéncia do refino e,
portanto, as condi¢cdes dinamicas serao satisfatorias. Porém, o comportamento
das bolhas quando se identifica 0 seu crescimento e desprendimento apds a
injecao do gas, ainda nao esta completamente esclarecida (Gu et al., 2023). Isso
ocorre pelo fato de faltar técnicas de medigdo que identifique corretamente o

diametro das bolhas em ascensao nos processos (Barral, 2016).

A presencga de bolhas em processos industriais € um fendmeno comum e,
nas ultimas décadas, microbolhas e nano-bolhas vém sendo amplamente
estudadas e aplicadas em diferentes contextos. Essas bolhas desempenham
papel fundamental na formacao de nanoestruturas, influenciando propriedades
fisicas e quimicas dos materiais processados (Tong, Liu e Guan, 2014). Em
outras areas da industria, como na flotagdo de minérios, a formagao de bolhas
também apresenta grande relevéncia, sendo que o tamanho dessas bolhas
exerce influéncia direta sobre o desempenho do processo. Bolhas menores, por
exemplo, aumentam a eficiéncia de separacdao e afetam variaveis fisicas
cruciais, como a taxa de captura de particulas, a estabilidade da espuma e a

seletividade do processo (Rodrigues, 2004).
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A existéncia de diferentes processos para a formacao das bolhas acarreta
seu tamanho, ou seja, dependendo do método de producado utilizado esse
definira o tamanho da bolha (Gu et al., 2023). Partindo do principio de que as
bolhas maijoritariamente no processo siderurgico sdo formadas a partir da
injecao do gas, esse tamanho correspondera em escala milimétrica (Lou e Zhu,
2013). A partir da precipitagao do gas dissolvido no liquido a formagéo de bolhas
também estara presente, levando em conta a queda de pressdo e o aumento
proveniente de temperatura o tamanho da bolha sera de microescala ou

nanoescala (Gu et al., 2023).

Na maior parte dos casos em que 0 ocorre o processamento de geragao
de bolhas, pela injecdo de gas a partir do sopro artificial e de alguma reagéo
interna, estara presente na superficie externa da bolha algumas forgas que séo
consideradas como flutuabilidade, a for¢a de cisalhamento e algumas forgas de
tensao superficial (Gupta, Sharma e Lakhera, 2016). Apesar disso, quando as
bolhas sdo formadas pela injecdo de gas o seu tamanho sera maior e outras
forgas estardo presentes, portanto se considera a forga de inercia do gas e a

forgca de inercia aplicada (GU et al., 2023).

Desse modo, a formagao de bolhas envolve algum tipo de escoamento.
Na industria metalurgia € muito presente os escoamentos multifasicos (Barral,
2016). Esse tipo de escoamento se caracteriza pela liberagdo simultanea de dois

ou mais fluidos (Gavioli, 2017).

Com o crescimento e desprendimento das bolhas geradas apds a inje¢cao
de gas nos reatores, o método de imagem de sombra (Shadow Sizing) comega

a ser utilizado para a medi¢cao dessas particulas.

3.3 Técnica PIV e Shadow Sizing

Com o passar dos tempos foram criando técnicas para que se pudesse
ter uma otima performance e obtencdo de resultados em caracterizagdo de
bolhas. Atualmente pode-se contar com grandes recursos computacionais que

estao disponiveis para a compreensio de problemas industriais e académicos
18



de maneira mais detalhada possivel (Barbi, 2016). Problemas para a
caracterizagao de particulas como bolhas na industria siderurgica estdo cada vez
mais recorrentes, portanto, se da necessario a utilizagdo de técnicas automaticas
para a caracterizagdo dessas particulas, a técnica empregada é restrita a fluxo
transparentes, essas técnicas podem fornecer informacgdes confiaveis e dados
seguros para a resolugéo de diversos problemas, fazendo com que o processo

de trabalho seja otimizado.

Ferramentas para analises visuais e para correlagdo de imagens de
escoamento multifasico em colunas de bolhas vem sendo utilizadas para se
determinar a velocidade e o tamanho da particula (Broder e Somerfeld, 2007).
Conforme se define a forma de trabalho € necessario que se faca a escolha da
melhor técnica possivel, atualmente diferentes técnicas estdo sendo aplicadas
para a medigdo de particulas, como € o caso da velocimetria por imagem de
particula (PIV) e a técnica Shadow (Forero, 2012).

Mecanismos que habitualmente vem sendo utilizados para se medir a
velocidade de uma bolha integram fotografia que sao feitas em alta resolugao e

dispositivos intrusivos e nao intrusivos (Kulkarni e Joshi, 2005).

As técnicas ndo intrusivas sdo caracterizadas por se utilizar um tracador
e conceber um indicador, sendo inserido no escoamento e transformando o fluxo
visivel de um aparelho de deteccao que esta fixado fora do campo de fluxo. O
uso desse metodo possibilita calcular a turbuléncia das bolhas, a sua medida
(tamanho) e a velocidade (Kulkarni e Joshi, 2005). Em medidas que se utiliza
métodos intrusivos um material € introduzido na parte do escoamento (Soares,
2005).

Os métodos nao intrusivos tém como caracteristicas representar apenas

uma fase em sua propriedade, dessa maneira € inevitavel a combinagao das

técnicas para a medigao (Broder e Somerfeld, 2002).
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3.3.1 Aplicagdes método Shadow PIV

Em seu trabalho Forero (2012) utilizou a técnica nao intrusiva PIV e a
técnica de sombras Shadow, como ferramentas para obter os dados necessarios
do escoamento para uma coluna de bolhas. Van Hout, Barnea e Shemer (2002)
realizaram um estudo de comparacgao para medir a velocidade de transferéncia
que a bolha ira atingir em escoamento pistonados para dissemelhantes
inclinagdes, usando o método de sombras e o método de tratamento onde se
obtém imagens em altas defini¢des. A solugéo obtida pelos dois métodos indica
resultados idénticos. Avaliaram ainda a velocidade da bolha utilizando a sua

localizac&o e a quantidade de imagens multiplicadas pelo tempo de captura.

No trabalho de Mayor et al. (2007) foi utilizado o método de captura de
imagem para avaliar a velocidade e dimens&o das bolhas. Subsequentemente,
utilizou um programa computacional para verificar as imagens e realizar o
tratamento. Matamoros (2013, p.64), “segue esta linha, onde as imagens
capturadas a altas frequéncias sao tratadas para obter o contorno, volume, area
seca, area molhada, area interfacial e comprimento das bolhas no escoamento

pistonado horizontal”.

A técnica mais praticada para que se obtenha dados do campo de
velocidade de escoamento é conhecida por Velocimetria por Imagem de
Particulas (Particle Image Velocimetry — PIV), nessa técnica a velocidade das
particulas presentes no escoamento €& estabelecida pela varredura de
deslocamento das particulas, em determinado periodo (Gavioli, 2017).
Determinados sistemas dispdem de desvantagens pela baixa frequéncia de
obtencao de dados, isso ocorre, pois, a analise é feita em um campo especifico
e ndo em um unico ponto (Galliani, 2011).

Os beneficios desse método para a medicédo de velocidade de particulas,
€ a possiblidade de se capturar o ordenamento da velocidade espacial em um
campo em alta resolugédo, ao contrario dos métodos classicos onde se tem a

medicdo por anemometria de fio quente ou a laser. Outra aplicabilidade
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importante dessa técnica que ela n&o € intrusiva, logo a sua medi¢cdo nao sera
atrapalhada por sensores internos. Tais beneficios tem feito do PIV um método

bastante util na determinac&o de fluxo instavel e turbulento (Matamoros, 2013).

Em seu estudo Raffel et al. (2007) citam caracteristicas desse método,
como principais temos que: i) a medida de velocidade € n&o intrusiva; ii) ocorre
também a medicao indireta da velocidade de escoamento a partir da velocidade
de particulas; iii) as medicbes sao feitas em uma regido ndo em um ponto
especifico do escoamento, iv) a capacidade para se determinar o vetor das
velocidades no escoamento pode ser realizada em trés dimensdes utilizando

planos de iluminagao e o sistema de captura das imagens.

Entretanto, tem se uma objecao para a utilizacdo desse método no estudo
da quantidade de bolhas, isso deve se a alta absor¢cédo dos penetrantes feixes de
luz que séo gerados pela dispersdo da superficie, com isso a realizagdo da
técnica limita-se a uma dimensao pequena na secao do fluxo e para pequenos

volumes de gas (Broder e Somerfeld, 2002).

Com os métodos computacionais existentes nos dias de hoje permitem
que a engenharia sempre siga avangando, isso nao seria diferente na industria
siderurgica. Utilizando esses meétodos € possivel o estudo minucioso do
comportamento das bolhas em reatores metalurgicos. Além do método de
Velocimetria por Imagem de Particulas (Particle Image Velocimetry — PIV) temos
também a técnica Shadow Sizing, um aprimoramento do método de medicao de

particulas por imagem.

A técnica de Shadow Sizing tem como principal objetivo a medicao 6ptica
de particulas, utilizado por meio de uma camera de alta velocidade e com alta
resolucdo, onde fornece resultados como a dimensdo e velocidade das
particulas. Geralmente é utilizado para se ter um aprimoramento nas colunas de
bolhas, essas bolhas de ar s&o geradas a partir da injegdo de um determinado
gas e logo apds ocorre a obtengcdo das imagens, onde um feixe de luz é
direcionado para a coluna de estudo e imagens sao captadas pela utilizagdo das
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cameras de alta velocidade. Apds a captagdo das imagens comega O seu
processamento, onde com o auxilio de um algoritmo se obtém as dimensdes das

particulas, definindo também a velocidade e o seu contorno (Oliveira, 2009).

Esse método também é utilizado para detectar particulas e se fundamenta
na diferenga que os contrastes entre a particula e o meio ocorrem, a técnica atua
como um refletor nas particulas (Forero, 2012). O método, porém, independe da
forma e do material em que a particula se encontra, com isso pode se estudar
particulas menores que 5 ym. A eficacia desse método esta atribuida a sua
simplicidade pratica relacionada com a percep¢ao completa do processo que

esta sendo estudado (Constantin, 2002).

Esse processamento das imagens permite a quantificacdo do tamanho
das particulas, as bolhas que sao tratadas através desse método
obrigatoriamente devem ser colocadas entre a fonte de luz difusiva e camera
digital de alta definicdo. Os objetos identificados por esse método tém como
principais caracteristicas: “posi¢ao”, “velocidade”, “diametro equivalente”,
“orientagao”, “excentricidade”, “fator de forma”, “perimetro” e “momentos de

inércia” (Oliveira, 2009).

O proposito que o algoritmo tem no processamento das imagens €
identificar as particulas individuais nas imagens e estabelecer seus contornos.
Em seguida ao reconhecimento do contorno da particula, as fotografias sao
processadas para que se possa entao realizar a identificacdo das propriedades

intrinsecas (Oliveira, 2009).

No estudo de Deen, Hjertager e Solberg (2000), foram equiparados os
mecanismos de medigao multifasica utilizando a técnica PIV, com a finalidade

de obter bons resultados a serem utilizados em simulagdes multifasicas.

Certos autores determinam os resultados a partir da conexdo do método
de sombras (Shadow) e o método PIV. Ja Nogueira et al. (2003) combinou ao
mesmo tempo esses dois métodos de caracterizacdo para definir a forma da
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bolha. Nos estudos de Sathe et al. (2010), foi mostrado observagdes sobre a
“forma”, “tamanho”, “velocidade” e “aceleracdo das bolhas” combinando o

método Shadow e o método PIV.
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4 MATERIAIS E METODOS

Nessa secao serdao apresentados os materiais e os respectivos métodos

utilizados para se obter a caracterizagdo de bolhas em modelo fisico.

4.1 Aparato Experimental

Foi utilizado um aparato experimental retangular de acrilico com
dimensdes de 48 x 28cm, onde foi adicionado um volume de agua a partir de sua

base com altura de 23 cm indicado na linha vermelha conforme a Figura 4.1.

Figura 4.1- Aparato experimental
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Para a avaliagdo do comportamento das bolhas, foram utilizados duas
pecas refratarias com caracteristicas distintas, conforme ilustrado na Figura 4.2.
O Refratario A é constituido integralmente por material poroso, o que permite a
passagem uniforme do ar em toda a superficie da base, favorecendo uma
distribuicdo homogénea das bolhas. Ja o Refratario B apresenta uma
configuragdo segmentada, composta por duas regides porosas separadas por
um inserto central de material denso, que bloqueia o fluxo de ar nessa faixa
intermediaria. Os refratarios foram cortados em espessura de 23 mm e depois
montadas em uma caixa de acrilico. Estas caixas foram colocadas

separadamente no interior do reservatdrio retangular com agua em temperatura
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ambiente. Na parte inferior das caixas em acrilico se conecta o tubo por onde é
injetado o gas (ar comprimido) como demostrado na Figura 4.3a. Apds a
realizacdo da montagem de todos os materiais e o posicionamento correto se
tem o esquema de montagem final do processo representado pela Figura 4.3b.

Foram empregadas as seguintes vazdes de ar: 1, 3 e 5 L/min.

Figura 4.2 - Montagem com pecas de material refratarios porosos utilizados para inje¢ao de
gas.

a) Refratario A; b) Refratario B

Figura 4.3 - Vista superior do sistema com caixa acrilica para aquisicdo de imagens das bolhas
formadas pela injegéo de gas no refratario.

a) Conexao do tubo no refratario para inje¢cao do gas; b) Montagem final
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4.2 Método Shadow Sizing

Para analise do tamanho de bolha foi utilizado o método Shadow Sizer a
partir do aparelho fabricado pela DANTEC presente no LaPSim DEMET/UFOP.
Os testes foram realizados de acordo com esquema apresentado na Figura 4.4
através da montagem de um sistema DANTEC-2D no qual € composto por um
laser Dual power- 65/15 400mJ sendo o laser ligado ao estrobo produzindo um
plano circular duragédo de pulsos de 4ns, faixa de comprimento de onda entre
1064nm e 532nm, uma camera CCD Flow-sense 2ME. A técnica de medicao de
sombra (Shadow) requer uma boa fonte de iluminagao para se obter imagens
com alta qualidade, o uso dos pulsos de luz muitos curtos permitem que o
movimento das particulas seja congelado, garantindo assim um bom contraste
na imagem. O posicionamento alinhado permite que o tamanho da area
iluminada seja ajustado para corresponder ao campo de visao da camera e,
assim, se beneficiar de toda energia do ShadowStrobe, a distancia ideal entre

camera e o Strobe é de 70cm.

Para todos os experimentos foram adquiridas 100 imagens, com
intervalos de pulsos do laser de 3000 us e frequéncia de captura de 10 Hz. O
tratamento das imagens foi realizado em software especifico (Dantec Dynamics),
sendo inicialmente conduzida a busca pela melhor configuragdo do método
Shadow Sizer. Embora esse conjunto completo de imagens estivesse disponivel,
para analise no ImagedJ, foram selecionadas aleatoriamente 10 imagens para
cada vazao de gas, as quais foram utilizadas na etapa de avaliagéo, de forma a

garantir representatividade e evitar viés na analise.
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Figura 4.4 - Esquema Shadow Sizing

4.2.1 Calibragao do Sistema de Medicado de Sombras (Shadow)

A calibragéo do sistema de medigdo Shadow tem como objetivo associar
a imagem capturada com uma escala em tamanho real. A partir do software
Dynamic Studio instalado no computador presente no laboratério de
Pirometalurgia do DEMET/UFOP, foi feita a calibragdo da imagem. Em um
primeiro momento com a camera e laser ja posicionados foi inserido uma régua
no interior do reservatorio, como demostrado na Figura 4.5. Apos a realizacao
da calibracao foi utilizado o mesmo software para o processamento das imagens,
como demostrado na Figura 4.6, onde se buscou identificar a melhor

configuragéo do sistema.

Figura 4.5- Imagem de calibragdo do método Shadow.
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4.2.2 Configuracao do Sistema de Medi¢gao de Sombras (Shadow)

As imagens capturadas foram processadas utilizando o método Shadow
Processing com o auxilio do software de analise. Primeiramente, clicou-se com
o botao direito sobre o conjunto de imagens desejado, o que abriu uma janela de
opgdes. Nessa janela, selecionou-se a opgao Analyze, conforme mostrado na
Figura 4.6a). Em seguida, uma nova caixa de dialogo foi exibida como
demostrado na Figura 4.6b), intitulada Select Analysis Method. Nela, navegou-
se até a categoria Particle Characterisation, localizada na lista lateral esquerda.
ApOs selecionar essa categoria, diversas op¢des de métodos de caracterizagéo
de particulas foram exibidas a direita, entre as quais foi escolhida a opgao

Shadow Processing.

Ao clicar em Shadow Processing, foi aberta a janela de configuracao do
método conhecida como Recipe - Shadow Processing. Nesta etapa, as
configuracbes foram realizadas conforme apresentado na Figura 4.6c),

respeitando os seguintes parametros:

a) O nivel de limiar (Threshold level) foi ajustado de forma a permitir a correta

diferenciacao entre bolhas e fundo;
b) A opcéo Edge height validation foi ativada, com o valor ajustado para 50%;

c) A funcdo Edge type validation também foi habilitada, com o controle deslizante

configurado na posigao mediana entre Smooth e Sharp;

d) Nas opg¢des adicionais, marcou-se Reject open contours para eliminar

contornos abertos, e a opgao Merge open contours foi desmarcada;

e) O filtro de area foi configurado com valores minimo e maximo de 500 e 50000,

respectivamente;

f) Em seguida, a opgédo Use entire region foi selecionada na aba Region of
interest, assegurando que todo o campo de imagem fosse considerado na

analise.
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g) Por fim, os dados foram extraidos e exportados para uma planilha do Excel.
Figura 4.6 - Configuragéo do Sistema de Medigdo de Sombras (Shadow)
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4.3 Medigcao Manual (ImageJ®)

Para analisar o tamanho das bolhas formadas pela injecdo de gas no
refratario, as imagens capturadas foram tratadas utilizando o programa livre
ImageJ®. Através de uma rapida calibragdo, utilizando uma imagem com escala,
0 programa permitiu calcular a area de varias particulas em uma mesma
imagem. As imagens passaram por um tratamento prévio para melhorar o
contraste, permitindo a identificacdo dos didmetros das bolhas mais faciimente.
Para cada vazao de gas, foram analisadas 10 imagens selecionadas de forma
aleatodria, de modo a garantir a representatividade e reduzir possiveis vieses na

avaliagao.
A calibragao do ImageJ® consiste em fornecer ao programa uma distancia
conhecida de modo a determinar a relagdo m/pixels na imagem. Para cada

imagem, o processo de medicao foi resumido em: a, b, ¢, d, e, f.

a) Inicialmente se fez a calibragdo do /ImageJ® utilizando uma régua como
demostrado na Figura 4.7a.
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b) Apés a realizagao da calibragdo a imagem esta preparada para que se possa
realizar as medidas das bolhas, na Figura 4.7b é mostrado a imagem preparada

para as medigdes.

c) Para a realizagdo das medigbes das bolhas, foi necessario acessar o menu
Image > Type e converter a imagem para o formato 16-bit. Em seguida,
procedeu-se a remogao do plano de fundo por meio do menu Process > Subtract
Background. Na janela aberta, a opgao Preview foi marcada, e o parametro
Rolling Ball Radius foi ajustado entre 50 e 500 pixels, de modo a melhorar o
contraste da imagem. ApoOs essa etapa, acessou-se o0 menu Image > Adjust >
Threshold para aplicar a limiarizacdo. Caso a imagem apresentasse regides
borradas, a etapa de subtragao do plano de fundo foi refeita com um valor mais

elevado do parametro Rolling Ball Radius.

d) As marcagdes nas bolhas foram avaliadas utilizando a ferramenta Wand
(tracing) tool. Para isso, foi necessario segurar a tecla Shift e clicar sobre cada
uma das bolhas passiveis de medicdo. Recomenda-se que essa sele¢ao tenha
sido comparada visualmente com a imagem original, especialmente nos casos
em que bolhas defeituosas ou contornos irregulares ndao tenham sido

completamente removidos durante o tratamento da imagem.

e) No menu Analyze > Analyze Patrticles, foi aberta uma caixa de didlogo na qual
foi definido um tamanho minimo de 4 mm? (correspondente a 1 mm de diametro).
A escolha pela medigao de bolhas maiores que 1mm se da pela dificuldade de
medidas em bolhas muito pequenas. Na opcdo Show, selecionou-se Outlines,

permitindo a visualizacdo dos contornos das bolhas identificadas.
f) O resultado foi apresentado em uma tabela, acompanhada por uma imagem

contendo os contornos das regides analisadas. Em seguida, os dados foram

extraidos e exportados para uma planilha do excel.
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Figura 4.7- a) Exemplo de escala para calibragdo do programa /ImageJ®; b) Imagem original
das bolhas
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5 RESULTADOS E DISCUSSOES

5.1 Medigao das bolhas
5.1.1 Shadow Sizing

A técnica de medigdo Shadow foi utilizada nesse trabalho para se fazer a
medicdo do tamanho de bolha, essa técnica automatica baseia-se nos
contrastes entre particula e meio. Esse sistema atua como um projetor na bolha,
eliminando outros fatores, como observado por Constantin (2002) a vantagem
dessa técnica acontece pela simplicidade experimental com a percepg¢ado do

processo.

A Figura 5.1 ilustra uma medicdo do didmetro das bolhas, utilizando a
técnica de processamento de imagens. E importante destacar que nem todas as
bolhas presentes no campo visual foram identificadas pela técnica, sendo
estimado que, para a vazéo de 1 L/min, aproximadamente 85% das bolhas foram

corretamente detectadas e medidas.

De acordo com Carneiro (2021), um dos principais desafios na
identificacdo automatizada de bolhas esta relacionado a presenga de contornos
aglomerados, o que dificulta a segmentacgao individual dos objetos. Por essa
razao, foi necessaria a validagao manual dos resultados obtidos. O mesmo autor
também observou que o software utilizado n&o foi capaz de distinguir de forma
eficiente o contorno individual das bolhas em certas regides, especialmente em
areas de alta densidade, levando a consideragcao de aglomerados como uma

Unica entidade durante a analise.

32



Figura 5.1 — Medicao das bolhas shadow vazéo 1 L/min
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Com o aumento da vazao de gas, observa-se um consequente incremento
na quantidade de bolhas formadas. Para vazdées mais elevadas, conforme
apresentado na Figura 5.2, a técnica automatica de medi¢do por sombra
(shadow sizing) foi capaz de identificar um numero significativamente maior de

bolhas, porém grande parte das bolhas maiores ndo foram medidas devido a

sobreposicao.

Além disso, esse aumento no numero de bolhas permitiu a técnica
registrar diferentes comportamentos dinamicos, dentre os quais se destacam:
colisdo seguida de rebote e colisdo com coalescéncia. A identificagdo desses
fendmenos reforga a sensibilidade da técnica automatica para captar nao apenas
a quantidade, mas também aspectos qualitativos relacionados a interagcéo entre

as bolhas em escoamentos com maior complexidade.

Figura 5.2 — Medig&o das bolhas shadow vazao de 3 L/min
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Em estudo realizado por Sathe et al. (2010), foram obtidos dados

referentes a forma, tamanho, velocidade e aceleragdao de bolhas por meio da
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técnica de sombra (shadow sizing), aplicada em uma coluna volumétrica. Os
resultados apresentados por Sathe et al. (2010) demonstram que a técnica de
medicdo por sombra é adequada para a caracterizacdo de particulas em
modelos fisicos. No entanto, o estudo também ressalta a necessidade de se
considerar a sensibilidade do método em relagdo ao movimento das bolhas, uma

vez que flutuagdes dindmicas podem interferir na precisao das medicdes.

5.1.2 Imaged®

Neste trabalho, também foi utilizado o software ImageJ® para o
processamento das imagens capturadas. O ImageJ® é uma ferramenta
amplamente empregada em analises de imagens cientificas, sendo capaz de
realizar diversas operagoes, tais como o calculo de areas, medicdes lineares,

determinacao de diametros e avaliagao de angulos.

Por se tratar de uma técnica de medicdo manual, observou-se uma
limitagdo quanto a identificagdo completa das bolhas, especialmente nas
condicbes de maior vazdo de gas. Tal dificuldade estd associada,
principalmente, ao fato de muitas bolhas apresentarem didmetros reduzidos ou
estarem sobreposta, 0 que compromete a precisdo da segmentagao e torna a
medicdo mais trabalhosa. A Figura 5.3 ilustra detalhadamente o procedimento

de processamento realizado com o ImageJ®.

Figura 5.3 —Medig¢ao das bolhas ImageJ® vazéo 1 L/min

Observa-se que, com o aumento da vazao de gas, ha uma maior
dificuldade na realizacdo da medicdo das bolhas. Esse efeito esta diretamente
relacionado ao incremento da velocidade do fluxo, que favorece a formacao de

um numero maior de bolhas, muitas delas com didametro reduzido. Essa

34



combinacdo de fatores compromete a eficiéncia da identificacdo e medicao,

especialmente em técnicas manuais, como evidenciado na Figura 5.4

Figura 5.4 — Medigao das bolhas ImageJ® vazao 3 L/min
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A diferenca pode ser atribuida a dificuldade de realizar medigbes precisas
em bolhas de didametro reduzido, especialmente em condi¢des de alta densidade
de bolhas. Em seu estudo, Santos (2023) realizou uma comparagéo entre duas
técnicas de medicao de bolhas e, apesar das limitagdes, o ImageJ® demonstrou

ser mais vantajoso em termos de reprodutibilidade e praticidade.

De forma semelhante, Aimeida (2019) observou que a técnica de medicéo
manual utilizando o ImageJ® tendia a apresentar valores ligeiramente superiores
para o diametro das bolhas, quando comparada a métodos automatizados.
Ambos os trabalhos evidenciam a importancia de um controle rigoroso na etapa
de processamento das imagens, uma vez que falhas nesta fase podem

comprometer a fidelidade dos resultados obtidos.

5.1.3 Comparativo entre Shadow Sizing e ImageJ

Para ilustrar essa diferenca entre os métodos de analise do tamanho de
bolhas, utilizou-se um comparativo na vazao intermediaria de 3 L/min. Na Figura
5.5 sdo apresentadas as imagens que demonstram as etapas principais da
analise visual: a) mostra a imagem original capturada pela camera, sem qualquer
tipo de processamento; b) apresenta o resultado do processamento automatico
realizado por meio da técnica Shadow Sizing; c) mostra a imagem processada

manualmente com o software ImageJ. A apresentagéo conjunta dessas imagens
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permite uma comparagao direta entre as abordagens e mostra, visualmente,

como cada método responde as diferentes condigdes operacionais.

Figura 5.5 — Comparativo Shadow e ImageJ

a) Imagem original; b) Shadow Sizing; c) ImageJ

b) e g

A Figura 5.5a) mostra a imagem original, sem qualquer tipo de
processamento. Nela, observa-se um ambiente com elevada densidade de
bolhas e significativa sobreposi¢ao, o que dificulta a identificagédo individual dos
contornos. De acordo com Sathe et al. (2010), esse tipo de configuragao é tipico
em sistemas com altas taxas de aeracao, onde a formacgao intensa de bolhas
leva a perda de nitidez e ao agrupamento visual, tornando a analise direta

bastante limitada.

Na Figura 5.5b) é apresentado o resultado da analise realizada por meio
do método automatico Shadow Sizing. Como demonstrado por Carneiro (2021),
essa técnica é capaz de detectar rapidamente bolhas pequenas e bem definidas,
mesmo em condi¢cdes dinamicas. No entanto, o método apresenta limitagdes
quando ha sobreposigao, ja que o algoritmo tende a excluir bolhas grandes ou

deformadas, priorizando formas regulares e isoladas.
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A Figura 5.5c) representa a medicdo manual feita no Imaged, na qual
realiza a identificagdo e o contorno individual de cada bolha apds o tratamento
da imagem. Embora esse método permita certo controle visual, ele se torna
problematico em imagens com sobreposicao significativa. Como apontado por
Almeida (2019), a segmentagcao manual em condi¢cdes de alta densidade pode
resultar em impreciséo, pois muitas bolhas acabam sendo agrupadas como uma

s6 ou ignoradas devido a dificuldade de separagéo visual.

E possivel concluir que o método automatico é mais eficiente na contagem
de bolhas pequenas, especialmente em ambientes com alta geracao e agitacao.
Por outro lado, a analise manual, apesar de permitir intervencbées mais
detalhadas, é limitada em termos de confiabilidade e reprodutibilidade em
condicbes de escoamento intenso, reforcando a importancia de escolher o

meétodo de andlise adequado conforme o regime de operacgao.

5.2 Analise da distribuicdao e diametros das bolhas

5.2.1 Distribuicao das Bolhas Medidas

Como mencionado ao longo deste trabalho, foram utilizados dois tipos de
refratarios porosos: Refratario A e Refratario B. Nesse contexto, o tamanho das
bolhas torna-se um fator relevante, considerando a importadncia dos
equipamentos de escoamento gas-liquido, nos quais a transferéncia de massa
esta diretamente relacionada a area superficial das bolhas. Segundo Lage and
Espdsito (1999), tanto a velocidade quanto a forma das bolhas varia conforme o

seu diametro.

A analise da distribuicao do tamanho das bolhas foi realizada por meio da
construcéo de histogramas, uma ferramenta estatistica que permite visualizar a
frequéncia com que diferentes tamanhos de bolhas ocorrem. No eixo horizontal
(eixo X), sao representadas as classes de didmetro das bolhas, organizadas em
intervalos regulares de 1 mm. Ja o eixo vertical (eixo Y) expressa a frequéncia
em porcentagem, ou seja, o percentual de bolhas que foram medidas dentro de
cada intervalo de didmetro. Assim, quanto mais alta a barra no histograma, maior
a quantidade de bolhas que apresentaram didametros dentro daquela faixa

especifica. Para esta analise, foram consideradas trés diferentes condi¢cdes de
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vazéao de ar: 1 L/min, 3 L/min e 5 L/min. Em cada uma dessas condicbes, a
geragcdo de bolhas foi registrada pelos dois métodos: o método automatico
Shadow Sizing, e o método /ImageJ. Ambos os métodos foram aplicados nos
dois tipos de refratarios, permitindo uma comparacgao direta da distribuicdo do

tamanho das bolhas em funcéo da técnica empregada.

As Figuras 5.6, 5.7 e 5.8 apresentam a distribuicdo do tamanho das
bolhas, comparando a medi¢ao por Shadow Sizing e por Imaged para o refratario

A nas vazbes de 1 L/min, 3 L/min e 5 L/min, respectivamente.

Figura 5.6 - Histograma vazéo 1 L/min refratario A
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Figura 5.7 - Histograma vazao 3 L/min refratario A
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Refratario A - 3 L/min
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Figura 5.8 - Histograma vazao 5 L/min refratario A
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A analise dos histogramas obtidos para o refratario A nas vazdes de 1, 3
e 5 L/min permitiu identificar o efeito da vazao sobre a distribuicdo dos diametros
das bolhas e também as diferencas de sensibilidade e precisdo entre o método
automatico (Shadow Sizing) e o método manual (ImageJ).

Na Figura 5.6 observa-se que o Shadow Sizing apresentou predominancia
de bolhas na faixa de 3,00-4,00 mm com 42%, seguida pela classe 2,00-3,00
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mm com 20%. Ja o ImagedJ concentrou a maior parte das ocorréncias em 4,00—
5,00 mm com 40%, com participacao relevante na faixa de 5,00—-6,00 mm. Esse
deslocamento para classes de maior diametro no método manual evidencia que
bolhas com menores didmetros ndo foram contabilizadas, devido a dificuldade

em distinguir visualmente bolhas pequenas.

A Figura 5.7 apresenta a vaz&o de 3 L/min, a diferenca entre os métodos
tornou-se ainda mais evidente. No Shadow Sizing observa-se a concentragéao na
menor classe analisada 1,00-2,00 mm, que representou mais de 62% das
ocorréncias, com queda acentuada nas classes de maior diametro. O Imaged,
por sua vez, apresentou distribuicdo mais espalhada, com dois picos de
frequéncia, em 2,00-3,00 mm e 4,00-5,00 mm, representando 29% e 27%
respectivamente, evidenciando que a técnica manual n&o capturou com a
mesma intensidade a redugao do didametro predominante, devido a dificuldade
de separar visualmente bolhas muito préximas em regides de maior densidade.
Além disso, para a vazao de 3 L/min foram observados desvios na distribuicao,
uma vez que os picos nao formaram uma curva continua como esperado,

indicando maior irregularidade no comportamento das bolhas.

Na condigdo de 5 L/min, como demostrado na Figura 5.8, ambos os
meétodos apresentaram distribuicdes mais semelhantes, com predominancia nas
menores classes de diametro, porém com diferengas na intensidade dessa
ocorréncia. O Shadow Sizing apresentou distribuicdo equilibrada entre 1,00-2,00
mm representando 43% e 2,00-3,00mm com 36%, enquanto o /mageJ
concentrou cerca de 55% na faixa de 2,00-3,00 mm, mantendo menor

frequéncia na menor classe.

As Figuras 5.9, 5.10 e 5.11 apresentam a distribuicdo do tamanho das
bolhas, comparando a medi¢ao por Shadow Sizing e por Imaged para o refratario

B nas vazdes de 1 L/min, 3 L/min e 5 L/min, respectivamente.
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Frequéncia (%)
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Figura 5.9 - Histograma vazao 1 L/min refratario B
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Figura 5.10 - Histograma vazao 3 L/min refratario B
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Figura 5.11 - Histograma vazéo 5 L/min refratario B
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Na Figura 5.9, com vazao de 1 L/min, a distribuicao das bolhas se mostrou
mais uniforme. O Shadow apontou um pico de frequéncia préximo a 39% na faixa
de 2,00-3,00mm, indicando uma alta concentragdao de bolhas nesse diametro,
mas com uma distribuicdo consideravel também na faixa de 1,00-2,00 mm. Por
outro lado, o ImagedJ revelou uma distribuigdo mais espalhada, na faixa de 3,00-
4,00 mm, e uma menor proporcado de particulas na faixa de 1,00-2,00 mm em

comparagao com o Shadow.

A medida que a vaz&o foi aumentada para 3 L/min, como demostrado na
Figura 5.10 o padrédo de medi¢cdo dos dois métodos divergiu ainda mais. O
método Shadow registrou um pico extremamente alto, com quase 50% das
bolhas concentradas na faixa de didmetro de 1,00-2,00 mm. Em contraste, o
Imaged apresentou o seu pico de frequéncia na faixa seguinte, de 2,00-3,00mm
com cerca de 33% das particulas. A frequéncia de particulas na faixa de 1,00-
2,00mm para o ImagedJ foi consideravelmente menor, reforcando a tendéncia de

que este método atribui um tamanho médio de particula maior ao material.

Na Figura 5.11 a vazao no refratario B sobe para 5 L/min. O método

Shadow novamente registrou um pico de frequéncia elevado, acima de 40%, na
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faixa de 1,00-2,00mm, enquanto o ImageJ manteve seu pico na faixa de 2,00-
3,00mm, com quase 47% das bolhas. Esta consisténcia na diferenca de
resultados entre os dois métodos, especialmente nas vazdes mais altas, sugere
que ha uma diferenca sistematica na forma como o Shadow e o ImageJ capturam
e classificam as bolhas. O Shadow € propenso a medir a bolhas de menor
diametro, devido a seu sistema de medi¢cado. Em contrapartida, o ImagedJ oferece
uma distribuicdo mais uniforme e com o pico de frequéncia em uma faixa de

diametro um pouco maior.

A ocorréncia de bolhas com didmetro superior a 5 mm é mais comum no
Refratario B, mesmo em altas vazdes, devido a sua estrutura de dupla camada
porosa, que favorece a retencdo de gas e a coalescéncia. Ja no Refratario A,
com porosidade mais uniforme, essas bolhas sao raras e ocorrem apenas em
baixa vazéo, pois o gas é liberado de forma imediata e dispersa, dificultando o

crescimento das bolhas.

De acordo com Forero (2012), o deslocamento da distribuicdo para a
esquerda indica a auséncia de bolhas com didmetros inferiores a 1 mm, no caso
da medicao realizada pelo ImagedJ, foi necessario delimitar manualmente um
diametro minimo para que as bolhas fossem consideradas na analise, o que
restringiu a detecgdo de bolhas muito pequenas. Em contrapartida, o método
automatico Shadow Sizing ndo apresentou essa limitagdo, sendo capaz de
identificar bolhas em uma ampla faixa de tamanhos, independentemente do
diametro. Como observado nos resultados, o Shadow Sizing realizou um numero
significativamente maior de medigbes em bolhas com didametro inferior a 2 mm,
evidenciando sua maior sensibilidade na detec¢do de bolhas pequenas. Além
disso, o autor observou que o aumento da velocidade superficial do gas
influencia diretamente no comportamento das bolhas. Segundo Azad e Syeda
(2006), o tamanho das bolhas, quando em equilibrio, depende principalmente do
volume de gas introduzido no sistema e do balango entre os fendbmenos de

quebra e coalescéncia.

Akita e Yoshida (1974) também destacaram que a distribuicdo das bolhas

varia conforme a regido analisada: proximo a saida do refratario, ha uma
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concentragdo maior de bolhas, enquanto nas regides mais afastadas a tendéncia
€ de dispersao. Essa maior concentragao inicial pode ser explicada pelo fato de
que, nesse estagio, as bolhas ainda ndo passaram por processos de deformagao
ou quebra. Esse comportamento justifica a presenca expressiva de bolhas com
didmetro acima de 2 mm nos dois tipos de refratarios, conforme verificado nas

medi¢cdes manuais.
5.2.2 Diametros das bolhas

Esta segdo apresenta uma analise comparativa da caracterizacdo de
bolhas geradas nos refratarios A e B, por meio das técnicas de medicado Shadow
e manual Imaged. Foram consideradas as principais caracteristicas
dimensionais das bolhas, incluindo didmetros minimo, maximo, médio e desvio

padrao.

A Tabela 5.1 apresenta os valores dos diametros das bolhas para as trés

diferentes vazdes estudadas nesse trabalho, para o refratario A.

Tabela 5.1 — Diametro das Bolhas refratario A

REFRATARIO A
1L/min 3L/min 5L/min

SHADOW | IMAGEJ SHADOW | IMAGEJ SHADOW | IMAGEJ
DIAMETRO | 1.494 2.523 1.269 1.339 1.289 1.012
MINIMO
DIAMETRO | 7.655 7.18 7.909 6.539 7.346 5.692
MAXIMO
DESVIO 0.982 0.961 1.105 1.34 1.125 0.835
PADRAO
DIAMETRO | 3.778 4.339 2.186 3.489 2.424 2.497
MEDIO

A Tabela 5.2 apresenta os valores dos didmetros das bolhas para as trés

diferentes vazbes estudadas nesse trabalho, para o refratario B.
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Tabela 5.2 — Diametro das Bolhas refratario B

REFRATARIO B
1L/min 3L/min 5L/min
SHADOW IMAGEJ SHADOW IMAGEJ SHADOW IMAGEJ
DIAMETRO 1.329 1.595 1.271 1.173 1.249 1.139
MINIMO
DIAMETRO 6.762 7.449 8.589 8.751 8.883 8.008
MAXIMO
DESVIO 1.352 1.468 1.331 1.591 1.352 1.003
PADRAO
DIAMETRO 3.135 4.008 2.497 3.611 2.597 2.909
MEDIO
Tabela 5.3 — Quantidade bolhas medidas
QUANTIDADE MEDIDA
1L/min 3L/min 5L/min
SHADOW | IMAGEJ SHADOW | IMAGEJ SHADOW | IMAGEJ
REFRATARIO | 787 434 2976 824 1657 452
A
REFRATARIO | 966 356 3119 992 2688 846
B

As Tabelas 5.1 e 5.2 apresenta a distribuicdo dos diametros das bolhas
obtidas para os Refratarios A e B e evidenciam diferengas consistentes entre as
técnicas Shadow e ImagedJ. Observou-se que a medicdo manual apresentou
didmetros médios sistematicamente maiores em ambos os refratarios, na
maioria das condi¢cdes de vazao analisadas. Segundo Carneiro (2021), estudos
que comparam analises manuais com métodos automatizados frequentemente
apontam para discrepancias devido a variabilidade humana e a interpretagao de

limites de bolhas.

As diferengas entre as técnicas também se manifestaram nos didmetros
minimo e maximo apresentados. Para o Refratario A, o ImagedJ identificou
didmetros minimos maiores nas vazdes de 1 L/min e 3 L/min, mas registrou o
menor valor minimo em 5 L/min. Por outro lado, o Shadow apresentou valores
maximos de didmetro em todas as condi¢des para esse refratario. No Refratario
B, o ImageJ apresentou didmetro minimo menor nas vazdes de 3 L/min e 5
L/min, mas apresentou didmetro maximo maior nas condi¢cées de 1 L/min e 3

L/min.
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Além disso, as diferengas observadas nos valores de desvio padrao
também séo relevantes. Segundo Zhang et al. (2013), as diferengas nos valores
de desvio padrdao também sao significativas, com o ImageJd apresentando
maiores desvios. Isso indica uma maior variabilidade nas medicbes e menor

reprodutibilidade, atribuida a natureza manual da técnica.

Ambos os refratarios exibiram uma tendéncia geral de diminuicdo do
diametro médio das bolhas com o aumento da vazao de 1 L/min para 3 L/min,
para ambas as técnicas avaliadas. Segundo Wu et al. (2021) o aumento da
vazéo intensifica as forgas de cisalhamento no ponto de inje¢do, favorecendo a
fragmentacao das bolhas. Esse comportamento justifica a tendéncia observada,
na qual ambos os refratarios apresentaram redugdo do diametro médio das
bolhas ao se elevar a vazdo de 1 L/min para 3 L/min, independentemente da
técnica de medigéo utilizada. Contudo, a 5 L/min, as tendéncias passaram a
divergir. No Refratario B, a técnica Shadow indicou um leve aumento no diametro
meédio das bolhas, enquanto o ImageJ manteve a tendéncia de redugao. Ja no
Refratario A, ambas as técnicas apresentaram um leve aumento no didmetro
médio entre 3 L/min e 5 L/min, com os valores convergindo significativamente

nessa ultima condicido de vazao.

A Tabela 5.3 apresenta a quantidade de bolhas medidas sendo
fundamental para avaliar a eficiéncia das técnicas de detec¢cdo de bolhas
aplicadas. De maneira consistente, a técnica Shadow demonstrou ser
significativamente mais sensivel, registrando um niamero muito maior de bolhas
detectadas em todas as condicdes de vazao e para ambos os tipos de refratario,
quando comparada ao Imaged. Essa disparidade torna-se ainda mais evidente
nas maiores vazdes (3 L/min e 5 L/min), o que pode estar relacionado ao
aumento da densidade de bolhas e a maior capacidade da técnica Shadow de
discriminar objetos em ambientes com maior complexidade visual. Por exemplo,
na vazao de 3 L/min, foram contabilizadas 2.976 bolhas no Refratario A pela
técnica Shadow, em contraste com apenas 824 bolhas detectadas pelo ImageJ.
No Refratario B, o padrao se repete, com 3.119 bolhas registradas pelo Shadow

contra 992 pelo Imaged.
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Segundo Schneider et al. (2012), o Imaged, por ser um método manual,
limita a quantidade de bolhas que podem ser processadas em um determinado
intervalo de tempo. Além disso, apresenta dificuldades na identificacdo e
contagem de bolhas em ambientes com alta densidade ou movimento rapido, o
que pode levar a subestimacdo da populacédo real de bolhas., Ja segundo
Carneiro (2021), a capacidade da técnica Shadow de processar um volume
maior de dados em menos tempo ndo apenas aumenta a robustez estatistica
dos resultados, mas também a torna mais viavel para aplicagdes de
monitoramento continuo em ambientes industriais, onde a velocidade e a

automacao sao essenciais.

Outro ponto relevante é que o refratario A apresentou didmetros médios
menores das bolhas em comparagdao ao refratario B, sugerindo que sua
porosidade e distribuicdo dos canais de injegdo favorecem a formagao de bolhas
mais finas e homogéneas. Nos estudos de Santos Junior (2020), também foi
observada diferenca significativa entre os tipos de refratario, reforcando a ideia
de que o material e a configuragao do refratario influenciam diretamente o
tamanho das bolhas formadas. Essa diferengca é relevante porque bolhas
menores tendem a permanecer mais tempo no banho metalico, aumentando a
eficiéncia na remocado de inclusdes e melhorando a homogeneizacdo da
temperatura e da composi¢cao quimica do acgo. Por outro lado, bolhas maiores
podem escapar mais rapidamente para a superficie ou se agrupar, reduzindo a
eficacia da injecdo de gas e potencialmente contribuindo para a formacgao de
defeitos superficiais ou inclusdes. Dessa forma, a escolha do refratario adequado
nao apenas impacta o tamanho das bolhas, mas também tem implicagbes diretas
na qualidade do produto, no controle de inclusdes e na eficiéncia do processo de

lingotamento continuo.

Assim, com base na analise das condi¢des experimentais, verifica-se que
nao ha discrepancias expressivas entre os didametros medidos, e os resultados
obtidos estdo em consonancia com o esperado, especialmente considerando a
maior densidade de dados proporcionada pela medicdo automatica. Vale
destacar que o didmetro das bolhas € um parametro essencial em sistemas gas-
liquido, como enfatizado por Santos Junior (2012), e discutido por Suzuki (2003)
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e Thomas (1997), que o didmetro das bolhas se torna maior com o aumento do
poro do material, ou seja, o refratario com dupla camada apresenta diametro

médio maior que o refratario poroso.

5.3 Efeito da vazao de gas no diametro das bolhas

O gas injetado forma muitas bolhas ao atravessar a parede do refratario
e entrar em contato com a agua. No entanto, esse efeito esta diretamente
relacionado a vazao do gas: quanto maior for a vazao, maior sera a quantidade
de bolhas geradas na interface gas-liquido. Wu et al. (2021) destacam que esse
fendbmeno pode ser explicado, principalmente, pela acdo combinada da forca de
flutuabilidade e do efeito de arrasto do fluxo, os quais influenciam
significativamente a formacao e o comportamento das bolhas apds sua liberagcao

no meio liquido.

A Figura 5.12 representa as imagens apds o seu processamento, indicam
o comportamento das bolhas: (a) vazdo de 1 L/min, (b) vazado de 3 L/min e (c)

vazao de 5 L/min, para o refratario A.

Figura 5-12 — Imagens processadas refratario A

a) Vazao 1 L/min; b) Vazao 3 L/min; ¢) Vazao 5 L/min

%
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A Figura 5.13 representa as imagens apos o seu processamento, indicam
o comportamento das bolhas: (a) vazdo de 1 L/min, (b) vazdo de 3 L/min e (c)

vazao de 5 L/min, para o refratario B.
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Figura 5-13 — Imagens processadas refratario B

a) Vazao 1 L/min; b) Vazao 3 L/min; ¢) Vazao 5 L/min

Nas Figuras 5.12 e 5.13, é possivel observar o efeito da vazao de gas
sobre as trajetérias das bolhas. Verifica-se que, com o aumento da vazao, ha um
acréscimo significativo na quantidade de bolhas geradas. Além disso, esse
incremento na vazao promove, de forma geral, a reduc¢ao do didmetro médio das
bolhas, ao mesmo tempo em que suas trajetérias se tornam mais alongadas, em

virtude do aumento da velocidade de ascens3o.

Wu et al. (2021) atribuem esse comportamento ao aumento do numero de
bolhas fluentes formadas logo apds a saida do gas pelos poros do refratario, o
que também intensifica a velocidade do jato gasoso. De modo complementar,
Yang, He e Zhai (2014) destacam que alteragdes nas trajetérias e na quantidade
de bolhas podem resultar em um escoamento mais denso na regido de saida do

refratario.

Ressalta-se que os estudos voltados a investigagdo do comportamento
inicial das bolhas, por meio de modelos fisicos utilizando agua como meio
simulador, tém se tornado cada vez mais frequentes. Nesse contexto, Lee (2009)
conduziu experimentos com amostras revestidas de refratario poroso a base de
Alumina e Silica simulando diferentes angulos de contato entre o ago e o gas,
considerando distintas permeabilidades. De maneira semelhante, Santos Junior
(2012) evidenciou que, ao ser injetado por meio do refratario, o ar percorre os
poros até alcancgar a interface gas-liquido, ponto no qual ocorre sua liberagédo na

forma de bolhas.
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A Figura 5.12 apresenta a distribuicdo das bolhas formadas no refratario
A, Thomas (1997) afirma que o didmetro das bolhas é influenciado por uma
combinagao de fatores, entre eles a vazao de gas injetada. Observa-se, assim,
que em maiores vazodes, a presenca de bolhas com didmetros reduzidos é mais

frequente, emergindo diretamente da superficie do refratario poroso.

Ainda segundo Thomas (1997), “as bolhas se concentram em regides de
baixa velocidade, as quais inclusive apresentam um fluxo de recirculagéo”, o que
reforca a influéncia do campo de escoamento sobre o comportamento das
bolhas. Complementarmente, Santos Junior (2012) destacou que, no caso de
refratarios com elevada porosidade, o fendmeno de coalescéncia entre bolhas é
intensificado, o que pode contribuir para a modificagdo do seu tamanho durante

O processo.

De forma semelhante ao observado no refratario B, a Figura 5.13
evidencia que o padrao de fluxo no refratario B é fortemente influenciado pela
vazado do gas. De acordo com Santos Junior (2012), o aumento da vazao
promove alteragdes significativas no comportamento das bolhas neste tipo de
refratario, comprometendo a uniformidade do escoamento do ar entre as

camadas e, consequentemente, afetando a formagao das bolhas.
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6 CONCLUSAO

Este trabalho investigou a aplicagdo de técnicas automaticas para a
caracterizagao de bolhas geradas pela injecao de gas inerte em reatores
metalurgicos, com énfase na comparacédo entre o método Shadow Sizing e a
medi¢do manual via ImageJ®. Através da utilizagdo de dois tipos distintos de
refratarios porosos totalmente poroso e com dupla camada separada por inserto

denso e variagdes de vazao de gas (1, 3 e 5 L/min).

Os resultados demonstraram que a técnica Shadow Sizing se mostrou
mais eficiente na identificacdo e caracterizacdo das bolhas pequenas,
apresentando maior representatividade em virtude da sua capacidade de
registrar um numero superior de particulas por imagem. Isso foi evidenciado,
principalmente, nas condi¢des de maior vazdo, onde a quantidade de bolhas
foram substancialmente elevadas. A técnica manual com o software ImageJ®,
por sua vez, embora pratica e acessivel, revelou-se limitada nas condi¢des de
alta densidade de bolhas, tanto em termos de resolucdo quanto de exatidao.
Ainda assim, sua aplicagdo se mostrou valida como complemento ao método
automatico, principalmente quando associada a um controle rigoroso do

tratamento das imagens.

Por fim, este trabalho contribui para a consolidacdo de metodologias
confiaveis no estudo de escoamentos multifasicos e reforga a importancia do uso
de ferramentas computacionais na Engenharia Metalurgica. A aplicagao correta
e calibrada dessa técnica pode contribuir significativamente para a melhoria dos
processos de refino secundario e para o desenvolvimento de modelos
experimentais, com impactos positivos na previsao de comportamento de bolhas

em escala industrial.
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7 SUGESTOES PARA TRABALHOS FUTUROS

Automatizacgao e Inteligéncia Artificial na Analise de Imagens:

o Integrar algoritmos para melhorar a segmentagéo de bolhas em imagens
complexas, especialmente em situagdes de alta densidade de particulas

ou sobreposicao.
Comparagao com Outras Técnicas de Software:

o Avaliar outros programas de analise de imagem além do Shadow Sizing
e ImageJ®, como MATLAB®, Python com OpenCV ou softwares
proprietarios, para medir bolhas com diferentes critérios de preciséao,

tempo e robustez.

Aplicacao em Processos Industriais Reais:

o Aplicar a metodologia desenvolvida em plantas industriais para
monitoramento e otimizagdo do processo de inje¢do de gas em tempo

real, visando reduzir defeitos e aumentar a eficiéncia do refino.
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